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1.  INTRODUCTION 

1.1.  Overview 

Today's energy-efficient windows can dramatically lower the heating and cooling costs associated with 

windows while increasing occupant comfort and minimizing window surface condensation problems.  

However, consumers are often confused about how to pick the most efficient window for a residence. 

Product information typically offers window properties:  U-factors or R-values, Solar Heat Gain 

Coefficients or Shading Coefficients, and air leakage rates. However, the relative importance of these 

properties depends on site- and building-specific conditions. Furthermore, these properties are based on 

static evaluation conditions that are very different from the real situation a window will be used in.  

A computer tool such as RESFEN can help consumers and builders pick the most energy-efficient and 

cost-effective window for a given application, whether it is a new home, an addition, or a window 

replacement. It calculates heating and cooling energy use and associated costs as well as peak heating and 

cooling demand for specific window products. Users define a specific "scenario" by specifying house type 

(single-story or two-story), geographic location, orientation, electricity and gas cost, and building 

configuration details (such as wall, floor, and HVAC system type). Users also specify size, shading, and 

thermal properties of the window they wish to investigate. The thermal properties that RESFEN requires 

are:  U-factor, Solar Heat Gain Coefficient, and air leakage rate. RESFEN calculates the energy and cost 

implications of the window compared to an insulated wall. The relative energy and cost impacts of two 

different windows can be compared. 

Table 6-2 lists the input assumptions used in RESFEN 6 

Update information, future releases, and program information about RESFEN and other software tools 

(such as WINDOW, THERM, and Optics) from the Windows and Daylighting Group at LBNL can be 

found at: http://windows.lbl.gov, in the Software section. 

1.2.  Changes from RESFEN 5 

The primary difference between RESFEN 5 and RESFEN 6 is modeling assumption changes to match 

those that were used for the Energy Star 2008 work done by LBNL.  

http://windows.lbl.gov/




RESFEN 6.0 DECEMBER 2012 2-1 

2.  QUICK START 

To get started with RESFEN, do the following: 

 Install the RESFEN program (see Chapter 3, "Installation"). 

 When the program is installed, double click on the RESFEN icon. 

 

Figure 2-1. Click on the RESFEN icon in the Programs/LBNL Software list. 

 The program will open with the default database, called RESFEN6.mdb. 

 Change any input values that are not correct for the case you wish to model.  For example, you can 

change the location to another city, change the HVAC system type, or input another window type.  

When you change an input value, the Calculate button becomes active and the values in the Results 

tabs are set to zero. 

Figure 2-2. Change input values as needed for your building. 

When RESFEN starts, it opens the input file database, 

called RESFEN6.mdb. 

Change the values 
in any of these 
input boxes to 
model your 
specific situation. 

When you change input values, the results boxes will be 
reset to "0, until you recalculate the results. 
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You can change the Window Data section either by entering all the values for each orientation by hand or 

by picking windows from a library of predetermined generic window products created with the 

WINDOW software. This library contains values for typical casement windows, but these values can be 

used for sliders and fixed windows because their properties are essentially the same. See Section 6.5, 

"Making Custom WINDOW Libraries" for detailed information about making your own libraries.  

Figure 2-3. Use the Window library to select windows foryour building. 

 

Input the infiltration value 

(Cfm/ft2) for the window you 
are analyzing (the program 
defaults to 0.3 cfm/t2.  

Type the total area of all windows on each of the four 
cardinal orientations into the Window input boxes.  

The values for U-

factor and SHGC will 
automatically update 
to the values of the 
selected window. 

Select the Window Type by either: 
 

 Clicking on the pulldown 
arrow to show the list from 
the Window Library 
 
 
 
 
 
 
 
 
 
 
 
 
 
OR 

 Click on the double arrow 
button to the right of the 
pulldown list to show more 
details from the Window 
Library list. 

Highlight a window 
from the library, and 
click on the OK 
button to select it. 
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Press the Calculate button -- the single lightning bolt calculates only Whole House results, and the 

double lightning bolt calculates both Whole House and Window Orientation results. 

Figure 2-4. There are two calculation options, accessed with the lightning bolt toolbar buttons. 

 An hourly simulation using the DOE2 calculation engine will be performed, which may take a few 

seconds for the Whole House only calculation, or somewhat longer for the Whole House + 4 

Orientations calculation, depending on the speed of your computer.  When the calculation is 

finished, the values in the Results tabs will be updated.  

 

Figure 2-5. The two calculation options are used to calculate different types of results. 

Whole House 
calculation 

Whole House Plus Four 

Window Orientations 
calculation 

The Whole House 
calculation the total 
annual energy 
consumption for the 
entire building, 
including conduction 
gains and losses 
from windows, walls, 
roof and 
foundations. 

The Whole House + 4 Orientations calculation 
produces results for the Whole House as well as the four window orientations, which are displayed on the 

Window Annual Energy, Window Energy Cost, and Window Peak Energy tabs. The results for the four 
window orientations are relative to a standard insulated wall for each orientation. 
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3.  INSTALLATION 

3.1.  Hardware Requirements 

First, make sure your computer system meets these specifications: 

 At least 16 MB of random access memory (RAM), configured as extended memory. 32 MB of RAM is 

preferred for optimum operation. 

 Microsoft Windows XP™, Windows Vista™ or Windows 7™. 

 Hard disk drive with at least 100 megabytes of available disk space. 

 Monitor and mouse. 

3.2.  Setup 

The installation program can be downloaded from the LBNL website at 

http://windows.lbl.gov/software/resfen/resfen.html  

The first step is to uninstall any previous versions of the RESFEN 6 program. However, RESFEN 5 can remain 

on your computer and does not have to be uninstalled. 

Once you have downloaded the installation program (RESFEN60SetupFull.exe), follow these steps to install 

the program: 

1. Using Windows Explore, browse to where the installation file was downloaded and double click on it. 

 

 

Figure 3-1. Double click on the downloaded installation file. 

http://windows.lbl.gov/software/resfen/resfen.html
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2. The initial RESFEN Preparing Setup window will appear.. 

 

Figure 3-2.  The initial RESFEN Setup window. 

3. When the initial Setup window has finished, a Welcome window will display. Click the Next button to 
proceed with the installation, or Cancel to stop. 

 

Figure 3-3.  The RESFEN Welcome screen. 
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4. The Software License Agreement window will display next. Read through the license and make sure 
you agree to all the terms before proceeding. To proceed with the installation, click on the Yes button, or 
click on No to stop.  

 

Figure 3-4.  The RESFEN License Agreement screen. 
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5. The Ready to Install the Program window will display next.  The directory where the program will be 
installed will depend on your operating system: 

 XP: 

o Program Directory (RESFEN6.exe):  

c:\Program Files\LBNL\RESFEN6 

o User Directory (all other RESFEN files):  

c:\Documents and Settings\<username>\LBNL\RESFEN6 

 Windows 7 / Vista 

o Program Directory (RESFEN6.exe):  

c:\Program Files(x86)\LBNL\RESFEN6 

o User Directory (all other RESFEN files):  

c:\Users\Public\LBNL\RESFEN6 

 

 

 

Figure 3-5.  Ready to Install the Program screen.  
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6. The Setup Status screen will appear, and the program files will automatically be copied into the 
appropriate directories. 

 

Figure 3-6.  Setup will decompress and copy the program files into the specified destination directory. 
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7. When the installation is complete, the InstallShield Wizard Complete screen will be displayed. Press 
Finish to finalize the installation. 

 

Figure 3-7.  The InstallShield Wizard Complete screen will display when the installation is finished. Press the Finish button to 

finalize the installation. 
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8. Setup will automatically put a RESFEN Icon in the Programs menu under the LBNL Software group, 
accessed from the Start button. 

 

Figure 3-8.  Program icon to run RESFEN. 
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3.3.  Running RESFEN  

To run RESFEN, click on the RESFEN 6 icon: 

 

Figure 3-9.  Click on Start / Programs / LBNL Software / RESFEN 3.1  
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The main program screen appears and starts by opening the default RESFEN database, called 

“RESFEN6.mdb”, as shown below.  

 

Figure 3-10. Main RESFEN screen. 
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3.4.  Uninstalling RESFEN 

If you need to uninstall RESFEN, follow the steps below. 

1. Go to the Control Panel and find the Add/Remove Programs choice (exactly where this is will depend 

on your computer’s operating system). 

 

Figure 3-11. Go to the Control Panel and find the choice to Uninstall a Program. 
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2. Select RESFEN5 from the list of currently installed programs and click on the Change/Remove 

button. 

 

Figure 3-12. Select RESFEN5 from the list of currently installed programs. 

3. The Preparing Setup screen appears. 

 

Figure 3-13. The Preparing Setup screen appears. 
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4. A dialog box appears asking if you want to remove the program. Click the Yes button 

 

Figure 3-14. The Preparing Setup screen appears. 

5. When the program is completely removed, the Uninstall Complete screen appears. Click the Finish 

button to complete the uninstall. 

 

Figure 3-15.The Uninstall Complete screen. 

6. The uninstall will delete files in the Program Files directory, but it will not delete files in your user 

directory. 
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3.5.  Troubleshooting 

Please send E-mail to RESFENhelp@lbl.gov if you have any trouble running the program. 

mailto:RESFENhelp@lbl.gov
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4.  PROGRAM DESCRIPTION 

4.1.  Overview 

RESFEN is a program with a simple user interface, shown in Figure 4-1, tied to a powerful analytical tool, 

DOE-2E (Lawrence Berkeley Laboratory, 1998).  The RESFEN default screen which opens when the program 

starts is the House Library Detailed View, which has several components: 

 Main Menu 

 Toolbar 

 House Data input section 

 Window Data input section 

 Results section 

Figure 4-1. Components of the RESFEN House Library Screen 

Results 
section 

Window 

Data 
input 
section 

House Data 
input 
section 

Toolbar 

Main Menu 
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4.2.  Steps to complete a RESFEN run 

The primary steps to complete a RESFEN calculation are: 

 Describe the  building configuration by entering the appropriate input values in the House Data 
section 

 Describe the windows in the building by entering the appropriate input values in the Window Data 
section 

 Click on one of the lightning bolt tool buttons to do either a Whole House or Whole House + 4 
Orientations calculation. 

 View the answers in the Results section when the simulation has finished. 

The following sections of this chapter describe the program in detail. 

4.3.  Toolbar 

RESFEN has a toolbar with buttons for the most commonly used functions, shown below. 

 

Figure 4-2.  Toolbar 

4.4.  Menus 

Each menu can be accessed with the mouse, by pointing and clicking on the menu choice, or with the 
keyboard, by pressing the Alt key and then typing the first letter of the menu name. For example, Alt-F 
would access the File menu. To select a menu choice, you can click on the choice with your mouse, type the 
underlined character of each menu choice, or use the Up and Down arrow keys. Keyboard shortcuts are 
indicated to the right of the menu item when available. 

4.4.1.  File 

The File menu is used to manipulate the RESFEN input files, to print the current screen, and to exit the 
program. Each set of input values on the main screen makes up a file, and different input configurations can 
be saved with different file names, so you can retrieve the input values as well as the results by opening the 
files that you save. RESFEN automatically opens the input file named "default.rsf" when the program starts. 
You can make changes to this file and save the changes to a new file name. RESFEN automatically adds the 
"RSF" extension to the file name that you provide. 

Previous Record 

First Record 

Next Record 

Whole House + 4 Orientation Calculation 

Whole House Calculation 

Last Record 
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Figure 4-3.  The File menu 

Close Close the RESFEN program. Equivalent to Exit. 

Open Open a RESFEN database, which will have an “mdb” extension. 

  

Figure 4-4.  The File Open dialog box. 

Save As Save the current database into another database. You can use this feature to develop 
different modeling scenarios and save them for future use. RESFEN supports the 
Windows 95™, Windows 98™, and WindowsNT™ long file-naming convention.  

 When the RESFEN program starts, it opens the last database opened.  If changes are 
made to this file, and you want to save it into a different database, use the Save As menu 
choice. 
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Figure 4-5.  Use the Save As feature to save the database under a different name for future use. 

Print Not currently implemented 

Print Setup Not currently implemented. 

Print Preview Not currently implemented. 

Report If there are results from a calculation, the results can be viewed in a report, as shown in 
the figure below. The report can be saved to a text file using the Save button, or printed 
using the Print button. If the “Wrap columns” checkbox is not checked, any data wider 
than the column will be truncated. 
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Figure 4-6.  The Report dialog box. 

 Recent File Shows the four most recently opened RESFEN databases. 

Exit Quits the program. 
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4.4.2.  Edit 

The Edit menu functions can be accessed from the Edit menu, and also using the standard shortcut keys listed 
in the menu. 

 

Figure 4-7.  The Record menu 

4.4.3.  Record 

The Record menu can be used to move between records (rows) in any of the Library screens, as well as to save 
edits made to the currently open record.  

 

Figure 4-8.  The Record menu 

4.4.4.  Libraries 

The RESFEN program consists of Libraries which are used to define a building model. The figure below 
shows the options in the Libraries menu.  

 

 Figure 4-9.  The Libraries menu 

The Libraries, which are described in detail in the rest of this section, are:  

House The House Library is where the definition of a specific building to be modeled is 
specified. The building data, location, and window data are all specified in the House 
Library. 

Locations The Location Library is used to specify information about a location for the RESFEN 
calculation engine, including the weather file for the DOE2 simulation, the building 
insulation packages to be used in the simulation, and the utility rates associated with the 
location. 

Window The Window Library is used to define a set of windows that can be used in the House  
Library window definitions. Records in the Window Library can be imported from the 
LBNL WINDOW program, or user defined. 
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Packages The Packages Library is used to construct a set of building envelope insulation 
definitions, such as the insulation level for the walls, floors, ceilings and foundation. 
These packages are then associated with a Location in the Location Library. 

Results The Results Library is where the results of each of the input definitions is stored. 
Different views of the results are possible from this library, and the results of multiple 
input definitions can be viewed at once, as well as exported to a comma separated text 
file which can be imported into a spreadsheet program for further analysis. 

Electric Rates The Electric Rates Library contains a list of electric rates which can be selected from in 
the Location Library. 

Gas Rates The Gas Rates Library contains a list of electric rates which can be selected from in the 
Location Library. 

 

4.4.5.  View 

The View menu is used to control the toolbar and status bar display settings. 

 

Figure 4-10.  The View menu 

4.4.6.  Options 

The Options menus is used to set program level default values. 

 
Figure 4-11.  The Options menu 

Unit System The system of units, from the choice of either: 

 IP: Inch pounds 

 SI: International units 
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Input Window  
Area as 

 Area (sf):  this option allows input of the window as actual area. Units: square feet 
(IP); square meters (SI). 

 % of floor area:  Currently inactive. (This option allows input of the window area 
based on the floor area.) 

DOE2 

Use WINDOW 
DOE-2 file This option allows specification of a DOE2 “dat” file, such as that generated by the 

WINDOW program, for one or more windows, to provide the DOE2 calculation engine 
with more detailed information about the window glazing characteristics. If this option 
is used, the House Library window input must use the WINDOW library option, and the 
ID numbers in the DAT file must match the ID numbers in WINDOW library. See 
Chapter 6, Section 6.4, “Using WINDOW DOE2 Input File for RESFEN Calculations” for 
more details about this option. 

Use custom 
DOE-2 template 
File Because RESFEN uses the DOE2 simulation engine to calculate the results, the program 

must have a DOE2 input file as a basis for that calculation. By default the program uses 
an encrypted file called RESFENTemplate.d2 for that input file. However, it is possible 
to use other DOE2 input files if they are constructed so that RESFEN can interpret them 
properly. In general, using an input file other than the default one supplied with the 
program is not advised. However, advanced users familiar with DOE2 may want to use 
this option. If so, it is best to start with a default text file that RESFEN can read, which is 
supplied with the program, called Template.new. This file can be edited (with extreme 
care not to make the file uninterpretable by RESFEN and DOE2) and then referenced 
from this Preferences option. If a file other than the default one is used, RESFEN will 
report that fact on the House Library Detail view as well as in the report. 

Prompt before 
Starting individual 
Window orientation 
Simulations If this box is checked, when the “double lightning bolt” button is clicked to generate 

results for the four orientations, RESFEN will put up the message box shown in the 
figure below. If this message is annoying, it can be eliminated by unchecking this box in 
the Preferences dialog box. 

 

Figure 4-12.  Message displayed before the House + 4 Orientations run begins. 

Display entire 
DOE-2 input file 
When errors are 
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Detected In the hopefully unlikely event that the DOE2 simulation engine cannot perform the 
calculation because of input errors, this option allows the user to see the raw DOE2 input 
file, with the errors indicated. This input file is not for the faint-of-heart, and will only 
make sense to someone very familiar with DOE2, which the typical RESFEN user should 
not need to be. If this happens (and it bascially never should), the best option is to 
contact LBNL at RESFENHelp@lbl.gov. 

4.4.7.  Help 

About Information about RESFEN, including the version number of the program. 
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4.5.  Libraries in General 

Libraries are the main components of the RESFEN program, and each library contains characteristics 

necessary for the calculations.  

4.5.1.  List and Detail Views 

There is a “List” and a “Detail” view of the data in each library. The List View shows all the records (rows) in 

the library but only some of the fields (columns with data), and the Detail View shows all the data (or fields) 

for one record. Most changes to the library records are made in the Detail View. 

Figure 4-13. Switching between the List View and Detail View in a Library.  

The List View of the House Library 

The Detailed View of the House 
Library for the selected record, ID #2. 

Click on the Detailed View button to see 
the Detail View of the selected record, 
where the values can be edited. 

Click on the 
List button 
to see the 
List View of 
the library 
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4.5.2.  Selecting Records from Libraries 

From many of the libraries, it is necessary to select records from other libraries. For example, in the Location 

Library Detail View, in order to define a location, it is necessary to select records from the Packages Library, 

the Gas Rates Library, and the Electric Rates Library. There are pull-down boxes for each of these inputs that 

will display the choices from the appropriate library. 

Figure 4-14. Selecting a record from another library. 

4.5.3.  Moving Between Records in Detail View 

There are several ways to move between records in the Library Detail View: 

 The Record Menu contains choices for First Record, Previous Record, Next Record, Last Record 

The pull-down list 
for Location in the 
House Library will 
show all the 
records in the 
Location Library. 
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 The Toolbar has buttons for first , previous , next , and last  record to move between 

records. 

Figure 4-15. Use the Toolbar buttons to move between records. 

Move between records 
using the toolbar buttons 



4.  PROGRAM DESCRIPTION 4.5.  Libraries in General 

RESFEN 6.0 DECEMBER 2012 4-13 

4.5.4.  Creating New Records 

New records can be created in all the libraries by copying an existing record (by highlighting it and clicking 

on the Copy button in the List View) and then editing the new record with the desired values in the Detailed 

View. The ID number for the new record is automatically incremented by the program based on the last ID 

number that was used. That value can be changed to any other number by the user, as long as the ID is 

unique. If the ID entered for the new record already exists, the program will ask if the existing record should 

be overwritten. There is also a checkbox in the “Adding a record” dialog box which tells the program to 

overwrite existing records without asking. 

Figure 4-16. Create a n ew record by copying an exi sting record in the List View of any library. 

Step 1: 
Click on the 
record to copy 
to highlight it. 

Step 2: 
Click on the 
Copy button to 
copy the 
highlighted 
record. 

Step 3: 
RESFEN will automatically assign 
a unique ID for the new record. A 
different ID number can be typed, 

as long as it is unique. Click OK to 
add the new record. 
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Figure 4-17. Create a n ew record by copying an exi sting record in the List View of any library. 

Figure 4-18. Create a n ew record by copying an exi sting record in the List View of any library. 

Step 1: 
Click on the 
record to copy 
to highlight it. 

Step 2: 
Click on the 
Copy button to 
copy the 
highlighted 
record. 

Step 3: 
RESFEN will automatically assign 
a unique ID for the new record. A 
different ID number can be typed, 

as long as it is unique. Click OK to 
add the new record. 

Step 1: 
Click on the 
record to copy 
to highlight it. 

Step 2: 
Click on the 
Copy button to 
copy the 
highlighted 
record. 

Step 3: 
RESFEN will automatically assign 
a unique ID for the new record. A 
different ID number can be typed, 

as long as it is unique. Click OK to 
add the new record. 
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Step 5: 
To edit the copied record, highlight the record and 
click the Detailed View button. 

Step 6: 
The detailed view of the highlighted record will 
open, and values can be edited as desired. 
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4.6.  House Library 

The House Library is where the building to be analyzed is defined. Because RESFEN is structured around a 
database, each building configuration can be defined as a separate record in the House Library. 

4.6.1.  House Library List View 

As with the other libraries, the House Library List View shows all the records in the currently open database.  

 

Figure 4-19. The House Library Detail View. 

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Copy Used to copy existing records to create new records which can then be edited as needed. 
Highlight the record or records to be copied (use Shift + left mouse click to select 
multiple contiguous records, or Ctrl + left mouse click to select multiple non-contiguous 
records), and click the Copy button. By default the program will increment the ID 
number based on the last ID value, but this can be changed by the user as long as the ID 
will unique for this library.  

Delete Used to delete existing records. Highlight the record or records to be deleted (use Shift + 
left mouse click to select multiple contiguous records, or Ctrl + left mouse click to select 
multiple non-contiguous records), and click the Delete button. 

Goto/Find Used to find a record in the library based on the Name field. When this button is clicked, 
a small dialog box will appear, and the beginning letters of the name can be typed, and 
the first record whose Name field starts with those letters will be highlighted. 
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4.6.2.  House Library Detailed View 

The detailed view of the House Library allows editing of all the building definition fields. 

 

Figure 4-20. The House Library Detail View. 

The following discussion explains the different sections of the House Library Detail View. 
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4.6.2.1.  House Data 

The left side of the main screen contains the House Data section, a series of pull-down lists that allow you to 
specify geographic location, house type, foundation type, HVAC type, floor area, and utility costs. 

 

Figure 4-21.  The House Data portion of the main screen 

ID# The ID# field is automatically created by the program, and is a combination of the 
record number (generated by the program when the record is created, such as using the 
Copy button in the List View) and the Name field (entered below). This value is in a 
pull-down list, which shows all the House Library records, and is another way to move 
between records in this library. 

Name Name of the record, input by the user. The Name is appended to the record ID number 
and used in the previous field.  

Location A pull-down list showing the entries in the Location Library. The location chosen is used 
by RESFEN to specify Typical Meteorological Year (TMY2) weather data used for the 
DOE-2 simulation. The location selection determines the default values for: 

 Envelope Package 

 Foundation Type 

House Type A pull-down list for specifying whether the building is one story or two story, new or 
existing construction, and what the predominant construction type is  either frame or 
masonry. For a two-story building case, the program assumes an equal floor area on 
each floor, based on the total floor area that you specify in the Floor Area input box. 

 1-Story New Frame 

 1-Story New Masonry 
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 1-Story Existing Frame 

 1-Story Existing Masonry 

 2-Story New Frame 

 2-Story New Masonry 

 2-Story Existing Frame 

 2-Story Existing Masonry 

 Default:  1-Story New Frame 

HVAC System 
Type A pull-down list for specifying the house's heating and cooling system. The efficiencies 

are different for New and Existing Construction (see Section 6.2, "RESFEN Modeling 
Assumptions" for details). 

 Gas Furnace / AC  

 Electric Heat Pump 

Floor Area The total floor area of the house. 
 Units:  square feet (ft2) (IP); square meters (m2)(SI) 
 Legal values:  1,000 to 4,000 square feet 

Envelope Package A pull-down list for specifying the insulation package for the building envelope. The 
choices in this list are from the Packages Library. The default values are based on the 
Location, but can be overridden by the user from this pulldown. When the Location is 
changed, the program will ask whether to use the default package from that Location. If 
the user says “Yes”, the package will be set to that associated with the Location in the 
Location Library. If the user says“No”, any package can be chosen from this list. The 
default packages in the Packages Library are based on the Model Energy Code (MEC) 
from 1993, and more packages can be created in the Packages Library. For more details 
about the Packages Library, see Section 4.10.  

Foundation Type A pull-down list for specifying the predominant type of foundation construction. The 
default value used by the program is based on the Default Foundation Type specified in 
the Location Library. However, it is possible to change that default value here in the 
House Library Detailed view. The possible foundation types are. 

 Basement 

 Slab-on-Grade 

 Crawlspace 

 Default:  dependent on the location selected. 

Set to Defaults Clicking on this button will reset the Envelope Package and the Foundation Type to the 
values defined in the Location Library.  

Electric Cost There are two input boxes for Electric Cost.  

 The first is a pull-down list, which shows the records in the Electric Rates Library. The 
default records that come with the program are one value per state. (See Section 4.12 for 
more details about the Electric Rates Library). Based on the selection from the pull-down 
list, electric rate in the box below it will change. The first choice in the pull-down list is 
User Defined, which allows the input of any value, overriding the value from the 
Electric Rates Library. 

 The second input box is a value representing the average cost of electricity for the 
location. This value initially is based on the choice from the Electric Rates Library, but 
can be edited by the user to any value. This number is multiplied by the energy 
consumption to calculate total cost.  
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 Legal Values:  Any number. 

 Units: $/kWh  

Gas Cost There are two input boxes for Gas Cost.  

 The first is a pull-down list, which shows the records in the Gas Rates Library. The 
default records that come with the program are one value per state. (See Section 4.12 for 
more details about the Gas Rates Library). Based on the selection from the pull-down 
list, Gas rate in the box below it will change. The first choice in the pull-down list is User 
Defined, which allows the input of any value, overriding the value from the Gas Rates 
Library. 

 The second input box is a value representing the average cost of Gas for the location. 
This value initially is based on the choice from the Gas Rates Library, but can be edited 
by the user to any value. This number is multiplied by the energy consumption to 
calculate total cost. 

 Legal Values:  Any number. 

 Units: $/Therm  

Description An optional field that can be used to record information about the case being modeled.  
 Legal Values:  Any character or number, up to 50 characters. 
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4.6.2.2.  Window Data 

The upper right-hand section of the screen is used to input information about the windows in the house for 
each of the four orientations, North, East, South and West, as well as Skylights, as shown in the figure below. 
Use your mouse, the Tab key or the arrow keys to move between the fields. 
 

 

Figure 4-22.  The Window Data portion of the screen 

When modeling the windows in your house, group the windows on an orientation together to determine the 
total area by orientation. If your windows do not face the exact cardinal orientations (north, south, east and 
west), use the closest orientations. The program has the capability of varying fenestration system parameters 
for each orientation. The NFRC total product properties, which include the glazing and frame, should be used 
for the area, U-factor, solar heat gain coefficient (SHGC), and infiltration (CFM per unit area). The Area 
parameter represents the total window area on any one facade in square feet or as a percentage of the total 
floor area (see detailed Area explanation below).  

Skylights are modeled as vertical glazing in the roof of the building, with solar heat gain reduced by 50% to 
account for skylight-well effects. This correction factor is a placeholder; research is ongoing to improve the 
skylight well solar correction. 

Because it is necessary to group windows by orientation, use the window properties for the window type that 
predominates on an orientation if the building has different types of windows on the same orientation. Input 
the total window area. For example, if all the windows on the west orientation are wood casements except for 
one aluminum frame picture window or one patio door with an area significantly less than the sum of the 
wood windows, model the west-facing windows as all wood casements. You could also obtain the properties 
for each window type on a given orientation and area-weight these values based on the square footage of 
each window type. 
 



4.6.  House Library 4.  PROGRAM DESCRIPTION 

4-22 DECEMBER 2012 RESFEN 6.0 

Window Type There are two options for Window Type, which are accessed by clicking on the Window 
Type pulldown list for each orientation: 
 

 
 

Figure 4-23.  Two Window Type choices, User specified or Window4 Lib. 

 User Defined:  Selecting the first choice in the pull-down list, User Defined, allows 
the user to enter the U-factor and SHGC window properties for each orientation. 
This choice can be used when comparing windows to get general trends about 
window technologies, but are not concerned about a detailed analysis for a 
particluar window. 

 Window Library Selection:  All the other choices in the pull-down list other than 
User Defined are records from the Window Library. In the Window Library, the 
user can create more windows, or import records created by the WINDOW 
program (see the WINDOW 5.0 User Manual). The U-factor and SHGC values from 
the Window Library are input automatically into those fields in the House Library 
Window Data. A default WINDOW library,  RESFENWindows.mdb, has been 
imported into the default REFEN database (RESFEN.mdb) and is included in the 
installation files. The values contained in this library are for single casement 
windows, but can be used for sliders and fixed windows because their properties 
are essentially the same. 
 
The double arrow button next to the pull-down list arrow shows the same records 
as the pull-down list, but displays more information about each record in a 
row/column grid, also allowing sorting by the grid column headings. 

 

Figure 4-24.  The double arrow selection button displays more information about the records in the 
Window Library. 
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  Figure 4-25.  Select window properties from the Window Library  

The selected entry is displayed in the Window Type input 
field, and the values from the library are automatically used 

in the U-factor and SHGC fields. Remember to change the 

Cfm field if necessary because it is not determined by the 
WINDOW 5 library. 

Highlight the desired record from 
either selection option (both 
selection options show the same 
records in the Window Library, 
but one shows more detail)  

To select a record from the Window Library, click on either 
the pull-down list or the double arrow  
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Window Total window area input as either total area or percent of total house floor area for each 
of four orientations. For example, if you want to model four windows that are 3’ x 4’ on 
the south orientation, the total window area for that orientation is 36 square feet, which 
is 2.3% for a house whose floor area is 1,560 ft2 (36/1540). 

 Units:  square feet (ft2)(IP), square meters (m2)(SI), or % of floor area (% Flr Area), 
depending on the settings in the Options menu. 

 Legal values: 0% to 12% per orientation; 0 to 480 square feet (4,000 square feet 
maximum floor area * 0.12 = 480); the sum of the percentages for the four orientations 
cannot exceed 48% of the floor area. 

U-Factor The U-factor of the total fenestration product at standard NFRC winter conditions, 
which includes the frame as well as the glazing, from a source such as the window 
NFRC label, manufacturer's literature, or a WINDOW 5 analysis.   

 Units:  Btu/hr-ft2-oF (IP), W/m2-o C (SI).  

 Legal values:  between 0.05 and 1.40 Btu/hr-ft2-oF at standard NFRC winter conditions. 

SHGC The Solar Heat Gain Coefficient of the total fenestration product, which includes the 
frame as well as the glazing, from a source such as the window NFRC label, 
manufacturer's literature, or a WINDOW 4.1 analysis. 

 Legal values: between 0.05 and 0.90. 

CFM/Area The infiltration of the total fenestration product (from ASTM E283 tests or equivalent), 
which includes the frame as well as the glazing.  

 Units: CFM/ft2. 

 Legal values: between 0.05 and 2.0 CFM/ft2. 

Solar Gain  
Reduction The type of solar gain reduction for the building, from the following list: 

 Typical: A statistically average solar gain reduction which includes some interior 
shade, overhangs, exterior obstructions and screens. See Section 6.2, "RESFEN 
Modeling Assumptions" for specific details. 

 None:  No interior shading, exterior overhangs, or obstructions. 

 Interior:  Interior drapes. See Section 6.2, "RESFEN Modeling Assumptions" for 
specific details. 

 Overhang:  two-foot exterior overhang at roof line. 

 Obstruction:  Used to model large obstructions, such as neighboring houses or 
other buildings. See Section 6.2, "RESFEN Modeling Assumptions" for details. 

 Int+Ovh:  A combination of the Interior and Overhang options. 

 Ovh + Obs:  A combination of the Overhang and Obstruction options. 

 Int + Obs:  A combination of the Interior and Obstruction options. 

 All:  A combination of the Interior, Overhang, and Obstruction options. 

East, South and 
West windows are  
The Same type  
as North Checking this box will set the Window Type values for the East, South and West 

windows to that of the North window. The program will ask you if you want to also set 
the window area to the same value as the North window. 

Total Area 
Window  
 Feedback only. This box displays the total window area of all the building orientations, 

including skylights; this total is calculated automatically by the program. 
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 Units: square feet (ft2) (IP), square meters (m2)(SI), or percentage of floor area (%), 
depending on the settings in the Options menu choice for Window Area. 

4.6.2.3.  Results 

The lower portion of the screen shows the results of the calculations, in the Results section. There are four 
tabs in this section, which display the following results: 
 

 Whole House:  the total annual energy consumption for the building, including conduction gains and 
losses from windows, walls, roof, and foundations. 

 Window Annual Energy:  the portion of the annual energy consumption attributed to the windows, 
broken down by four window orientations. 

 Window Energy Cost: the portion of the annual energy cost attributed to the windows, broken down 
by four window orientations. 

 Window Peak Energy: the portion of the peak energy consumption attributed to the windows, 
broken down by four window orientations. 
 

 

Figure 4-26. The Results section contains four different sets of results. 
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When you have input all the appropriate values into the House Data and Window Data sections, to start the 
simulations, click either: 

 the Whole House Calculation toolbar button  

or  

 the Whole House + 4 Orientations toolbar.  

These two different calculation types are described below:  
 

 Whole House:  this option calculates the energy consumption for the entire house. It includes energy 
use attributable to the building windows, walls, roof, and foundation (including infiltration). It does 
not include lighting or appliance or hot water energy consumption. If this calculation is selected, only 
the Whole House tab will be displayed in the Results section. 

 Whole House + 4 orientations:  this option calculates the energy consumption of the entire house and 
also the energy attributed to only the windows, for each orientation. Because separate simulations are 
run for the whole house and each window orientation, this calculation can take some time, depending 
on the speed of your computer. If this calculation is selected, all four tabs will be displayed in the 
Results section. 
 
The window results by orientation are all relative to a standard insulated windowless wall. Positive 
values mean that the window uses more energy than an insulated wall with no windows; negative 
values mean that the window uses less energy than an insulated wall with no windows. All cooling 
results will be positive, but heating energy use can be either positive or negative. If the results are 
positive, the smallest value will be the most energy-efficient window configuration. If the results are 
negative, the largest negative value will be the most energy-efficient window configuration. When 
comparing positive and negative results, the window configurations with negative results will be the 
most energy efficient. It is possible for a window configuration to use less heating energy than an 
insulated wall (and thus have a negative result) because the solar heat gain from the window 
provides heat to the space and reduces the heating requirements of the building. 

The results are reset to 0 whenever any changes are made to the input values, so you must recalculate the 
results.  



4.  PROGRAM DESCRIPTION 4.6.  House Library 

RESFEN 6.0 DECEMBER 2012 4-27 

4.6.3.  Whole House  

The Whole House results show the total annual energy consumption for the building, broken into the 
following results: 

 Energy Totals 

 Energy per ft2 

 Total Cost 
 

 

Figure 4-27. The Results tab for the Whole House calculation. 

Annual Energy  
Totals Total annual energy consumption for the entire house, broken into the following 

components: 

 Heating:  The annual heating energy consumption for the entire house. 
Units:  MBtu/year (IP), GJ (SI) for Gas Furnace; kWh/year (IP and SI) for Electric 
Heat Pump. 

 Cooling:  The  annual cooling energy consumption for the entire house. 
Units:  kWh/year (IP and SI). 

 Total:  The annual total energy consumption for the entire house. 
Units:  MBtu/year (IP), GJ/year (SI) for Gas Furnace/AC ; kWh/year (IP and SI) 
for Electric Heat Pump. 

Energy per ft2 The annual energy consumption for the entire house divided by the area of the house, 
broken into the following components: 

 Heating:  The annual heating energy consumption for the entire house per floor 
area. 
Units:  kBtu/ ft2 (IP), GJ/m2 (SI) for Gas Furnace; kWh/ ft2 (IP), kWh/ m2 (SI) for 
Electric Heat Pump. 

 Cooling:  The annual cooling energy consumption for the entire house per floor 
area. 
Units:  kWh / ft2 (IP), kWh /m2 (SI). 

 Total:  The annual total energy consumption for the entire house per floor area. 
Units:  MBtu/ ft2 (IP), GJ/ m2 (SI) for Gas Furnace/AC ; kWh/ ft2 (IP), kWh/ m2 
(SI) for Electric Heat Pump. 

Total Cost The cost of the annual energy consumption for the entire house, which is the energy 
totals multiplied by electricity and gas prices, broken into the following components: 
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 Cooling:  The cost of the annual cooling energy consumption for the entire house. 
This value should equal the Cooling Energy Total multiplied by the Electricity cost. 
Units:  $/year 

 Heating:  The cost of the annual heating energy consumption for the entire house. 
This value is the Heating Energy Total multiplied by either the Gas cost for gas 
furnaces or the Electricity cost for heat pumps. 
Units:  $/year 

 Total:  The total cost of the annual energy consumption for the entire house. This 
value is the sum of the heating and cooling costs. 
Units:  $/year 

4.6.3.1.  Window Annual Energy 

The Window Annual Energy results show the portion of the annual energy consumption of a building that 
can be attributed to the window being modeled. Positive values mean that the window adds that amount to 
the energy consumption of the house on an annual basis. Negative values can occur for heating, meaning that 
the window provides heating in the form of useful solar gain, which more than compensates for heat lost, and 
helps to lower the house's heating energy consumption. The first four columns represent the four window 
orientations (north, east, south and west). The fifth column represents skylights. 
 

 

Figure 4-28. The Results tab for Window Annual Energy. 

Cooling/ft2 Cooling energy per unit window area. 
Units: kWh/ft2-year (IP), kWh/m2-year (SI). 

Heating/ft2 Heating energy per unit window area. 
Units:  kBtu/ft2-year (IP), GJ/m2-year (SI) for Gas Furnace; kWh/ft2-year (IP), kWh/m2-
year (SI), for HeatPump. 

Cooling Energy Cooling energy attributed to windows.  
Units:  kWh/year (IP and SI) 

Heating Energy Heating energy attributed to windows. 
Units:  MBtu/year (IP), GJ/year (SI) for Gas Furnace, or kWh/year (IP and SI) for 
HeatPump. 
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4.6.3.2.  Window Annual Cost 

The Window Annual Cost result shows the difference between the annual energy cost of a building with the 
window being modeled and with a windowless wall. The energy use values in the Window Annual Energy 
result are converted to costs using the input values for electricity and gas. Positive values mean that the 
window uses more energy than a standard insulated wall with no windows; negative values for heating mean 
that the window uses less energy than a standard insulated wall with no windows. Negative values represent 
economic savings that will offset other energy-consuming features in the house, thus reducing the total home 
heating bill. 
 

 

Figure 4-29. The Results tab for Window Energy Cost. 

Cooling ($/area) Cooling energy per unit window area. 
Units:  $/ft2-year (IP), . $/m2 (SI) 

Heat ($/area) Heating energy per unit window area. 
Units:  $/ft2-year (IP), . $/m2 (SI) 

Cooling ($) Cooling energy attributed to windows. 
Units:  $/year. 

Heating ($) Heating energy attributed to windows. 
Units:  $/year. 

Total Energy ($) Sum of the Cooling and Heating Energy Cost. 
Units:  $/year. 
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4.6.3.3.  Window Peak Demand 

The Window Peak Demand result shows the difference between the peak energy demand of a building with 
the window being modeled and with a windowless wall. Positive values mean that the window has a higher 
peak demand than a standard insulated wall with no windows; negative values mean that the window has a 
lower peak demand than a standard insulated wall with no windows. 

Peak heating and cooling loads determine the required size of the furnace and air conditioner needed to meet 
maximum thermal loads. Lower peak demand means smaller, less expensive equipment. Peak heating 
conditions typically occur on cold winter nights, and peak cooling conditions typically occur on hot, sunny 
summer afternoons. Make sure that the equipment sizing calculations done by your HVAC contractor take 
into account the benefits of high-performance windows. 
 

 

Figure 4-30.  The Results tab for Window Peak Energy. 

Cool Peak/ 
Unit Area Cooling peak per unit window area. 

Units: W/ft2 (IP). 

Heat Peak/ 
Unit Area Heating peak per unit window area. 

Units: Btu/ ft2 (IP). or kW (IP and SI) for HeatPump. 

Cooling Peak Cooling peak attributed to windows. 
Units: kW (IP and SI). 

Heating Peak Heating peak attributed to windows. 
Units: kBtu/hr  (SI and IP) or kW (SI and IP) for HeatPump.4.7.  Location Library 

The Location Library is used to define new locations for calculations. RESFEN comes with over 200 locations 
predefined, and if the appropriate weather files for the DOE2 simulation can be obtained, more locations can 
be added.  

The information contained in the Location Library includes: 

 Weather file for the DOE2 simulation 

 Insulation package which determines the level of insulation for the building envelope 

 Utility rates for that location which are used to calculate the building energy costs 

Because the insulation levels for the calculation are contained in the Location Library, it is possible to make a 
new record in this library, using the same weather file and utility rates, but specifying a different insulation 
package. 
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4.8.  Location Library 

4.8.1.  Location Library List View 

The Location Library List view shows all the records that are in the library. Some of the records in the 
Location Library do not have all the information defined, such as the insulation packages. These records have 
an “*” in front of the name, and should not be used for calculations. 

 

Figure 4-31. The Location Library List View. 

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Copy Used to copy existing records to create new records which can then be edited as needed. 
Highlight the record or records to be copied (use Shift + left mouse click to select 
multiple contiguous records, or Ctrl + left mouse click to select multiple non-contiguous 
records), and click the Copy button. By default the program will increment the ID 
number based on the last ID value, but this can be changed by the user as long as the ID 
will unique for this library.  

Delete Used to delete existing records. Highlight the record or records to be deleted (use Shift + 
left mouse click to select multiple contiguous records, or Ctrl + left mouse click to select 
multiple non-contiguous records), and click the Delete button. 
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Goto/Find Used to find a record in the library based on the Name field. When this button is clicked, 
a small dialog box will appear, and the beginning letters of the name can be typed, and 
the first record whose Name field starts with those letters will be highlighted. 

4.8.2.  Location Library Detail View 

The Location Library detailed view shows all the input values for each individual record, as shown in the 
figure below. 

 

Figure 4-32. The Location Library Detail View. 

The fields in the Location Library detailed view are the following: 

ID The ID of the record, set automatically by the program or by the user when copying an 
existing record. This ID must be unique. 

Name The name of the record, which can be any text. The default locations are named by the 
state abbreviation first, then the city name. 

Existing Package The building envelope insulation package to be used for this location, from the Package 
Library. This insulation package will be used if “Existing” is selected in the House Type 
pull-down in the House Library. See the section on Package Library in this manual for 
more information about adding new insulation packages to that library. This value can 
be changed from the House Library for a particular modeling scenario. 

New Package The building envelope insulation package to be used for this location, from the Package 
Library. This insulation package will be used if “New” is selected in the House Type 
pull-down in the House Library. See the section on Package Library in this manual for 
more information about adding new insulation packages to that library. This value can 
be changed from the House Library for a particular modeling scenario. 

Default foundation The default foundation type for the location. This value can be changed from the House 
Library for a particular modeling scenario. The types to select are: 

 Crawlspace 

 Slab-On-Grade 

 Basement 
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Weather File  
Name The name of the DOE2 weather file, which must exist in the Weathr directory under the 

RESFEN program directory. These are binary files that contain weather data specifically 
formatted for the DOE2 simulation program which RESFEN uses for the calculations. In 
general, these weather files need to come from LBNL and cannot be generated by the 
user. 

4.8.3.  Location Databases 

Each record in the Location Library references a weather file for RESFEN to use in the building calculation. 
There are default databases that come with the program which reference different sets of weather files. Other  
databases are available on the LBNL RESFEN website Knowledge Base  
(http://windows.lbl.gov/software/resfen/resfen.html)  

 RESFEN.mdb:  the default database that RESFEN opens, which contains all the US cities defined in 
the Location Library, with a few example House Library records 

 RESFEN-CanadaWthr.mdb:  a database which has all the Canadian cities (locations with DOE2 
weather data) in the Location Library, with a sample record for each location defined in the House 
Library. 

 RESFEN-Chile.mdb:  a database which has all the US cities defined in the Location Library, and a 
House Library record defined for each of those US locations 

 RESFEN-ChinaWeather.mdb: a database which has all the Chinese cities (locations with DOE2 
weather data) in the Location Library, with a sample record for each location defined in the House 
Library. 

http://windows.lbl.gov/software/resfen/resfen.html
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4.9.  WIndow Library 

The Window Library is used to define windows that can be used in the House Library input. The records in 

the Window Library can be imported from WINDOW databases,  or they can be defined by the user. 

4.9.1.  Window Library List View 

The Window Library List view shows all the records that are in the library. The default records in the library 

were imported from a WINDOW library (RESFENWindows.mdb, which is installed automatically in the 

RESFEN program directory). These default windows correspond to the default windows shown on the 

Efficient Windows Collaborative website (www.efficientwindows.org). It is possible to create new records in 

this library by either: 

 Copying an existing window using the Copy button in the List View. Then highlight that record and click 
the Detailed View button and edit the input values for the new window as needed. 

 Importing records from a WINDOW database using the Import button. This method is explained in more 
detail later in this section 
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The screen below shows the List View of the Window Library. 

 

Figure 4-33. The Window Library List View. 

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Copy Used to copy existing records to create new records which can then be edited as needed. 
Highlight the record or records to be copied (use Shift + left mouse click to select 
multiple contiguous records, or Ctrl + left mouse click to select multiple non-contiguous 
records), and click the Copy button. By default the program will increment the ID 
number based on the last ID value, but this can be changed by the user as long as the ID 
will unique for this library.  

Delete Used to delete existing records. Highlight the record or records to be deleted (use Shift + 
left mouse click to select multiple contiguous records, or Ctrl + left mouse click to select 
multiple non-contiguous records), and click the Delete button. 
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Goto/Find Used to find a record in the library based on the Name field. When this button is clicked, 
a small dialog box will appear, and the beginning letters of the name can be typed, and 
the first record whose Name field starts with those letters will be highlighted. 

Import Used to import window records from a WINDOW database. To use this feature, 
windows need to be created in the WINDOW program, which is used to define accurate 
U-value and SHGC values from detailed information about the window frame and 
glazing system. See the WINDOW User’s Manual for details about making that database, 
or visit the website at http://windows.lbl.gov/software. 

 To import records from the WINDOW database, click the Import button. A dialog box 
will appear, where the WINDOW database can be specified  

 

Figure 4-34. Importing a WINDOW window database. 

 The Browse button can be used to locate the WINDOW database. The default WINDOW 
database installed with RESFEN is called RESFENWindows.mdb, and the records in that 
database are the default records in the RESFEN Window Library. 

 Click OK when the database path has been entered,  and the program will open the 
database and display the records that can be imported. 

  
Figure 4-35. Select records from the  WINDOW window database to  

be imported into the RESFEN Window Library. 

 Select the records to be imported (multiple records can be highlighted using Ctl  and 
Shift with mouse clicks) into the RESFEN Window Library, and click the OK button. 
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Figure 4-36. Select records from the  WINDOW window database to  

be imported into the RESFEN Window Library. 



4.9.  WIndow Library 4.  PROGRAM DESCRIPTION 

4-38 DECEMBER 2012 RESFEN 6.0 

4.9.2.  Window Library Detail View 

The Window Library detailed view shows all the input values for each individual record, as shown in the 

figure below. 

 

Figure 4-37. The Package Library List View. 

The fields in the Package Library detailed view are the following: 

ID The ID of the record, set automatically by the program or by the user when copying an 
existing record. This ID must be unique. 

Name The name of the record, which can be any text. If the records were imported from 
WINDOW, the Name is the same as the Name value in the WINDOW database. 

Type Unused 

Source The source of the data. 

 For records imported from a WINDOW database: The name of the WINDOW database 
where the record was imported from, including the computer path of the database 
location. 

 For records copied from an existing record: Set automatically to User 

Height The height of the window, either from the WINDOW database or input by the user. 

 Units: inches (IP) 

Width The width of the window, either from  the WINDOW database or input by the user. 

 Units: inches (IP) 

Area The area of the window, either from the WINDOW database or input by the user. 

 Units: square feet (IP) 

Ufactor The U-factor of the window, either from the WINDOW database or input by the user 

. Units: Btu/ft2-h-oF (IP) 
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SHGC The Solar Heat Gain Coefficient, either from the WINDOW database or input by the 
user. 

Protected This field controls whether the data in the record can be edited. If it is checked, the fields 
in the record cannot be edited, and that field cannot be unchecked. If it is not checked, 
the data can be edited. Records imported from a WINDOW database automatically have 
the Protected field checked. Fields created by copying another record, even a record 
from a WINDOW database, are not protected. 
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4.10.  Packages Library 

The Package Library is used to defined the building envelope insulation levels for the following building 
components: 

 Ceiling 

 Wall 

 Floor 

 Crawlspace 

 Basement 

These packages are referenced from the Location Library and are used in to define the building when that 
location is referenced in the House Library. 
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4.10.1.  Packages Library List View 

The Package Library List view shows all the records that are in the library. The default records in the library 
are based on the requirements for the default locations that come with the program. It is possible to make new 
insulation packages in this library by copying an existing package using the Copy button in the List View. 
Then highlight that record and click the Detailed View button and edit the input values for the new package, 
including the name, as needed. 

 

Figure 4-38. The Package Library List View. 

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Copy Used to copy existing records to create new records which can then be edited as needed. 
Highlight the record or records to be copied (use Shift + left mouse click to select 
multiple contiguous records, or Ctrl + left mouse click to select multiple non-contiguous 
records), and click the Copy button. By default the program will increment the ID 
number based on the last ID value, but this can be changed by the user as long as the ID 
will unique for this library.  

Delete Used to delete existing records. Highlight the record or records to be deleted (use Shift + 
left mouse click to select multiple contiguous records, or Ctrl + left mouse click to select 
multiple non-contiguous records), and click the Delete button. 

Goto/Find Used to find a record in the library based on the Name field. When this button is clicked, 
a small dialog box will appear, and the beginning letters of the name can be typed, and 
the first record whose Name field starts with those letters will be highlighted. 
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4.10.2.  Packages Library Detail View 

The Location Library detailed view shows all the input values for each individual record, as shown in the 
figure below. 

 

Figure 4-39. The Package Library Detail View. 

The fields in the Package Library detailed view are the following: 

ID The ID of the record, set automatically by the program or by the user when copying an 
existing record. This ID must be unique. 

Name The name of the record, which can be any text. The default packages are used in the 
default locations, and are named according to whether they are to be used to define the 
insulation levels for New or Existing construction.  

Residential Construction Values 
The names of the insulation levels reflect the R-value of the insulating layer, not the overall R-value of the 
wall. The U-values that correspond to these R-value constructions are documented in Table 6-5. 

Ceiling The level of ceiling insulation for this package, from the predefined list of the following 
values: 

 R11 

 R19 

 R22 

 R26 

 R30 

 R38 

 R49 
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Wall The level of wall insulation for this package, from the predefined list of the following 
values: 

 R7 

 R11 

 R13 

 R14 

 R19 

 R21 

 R28 

Crawl Slab The level of crawlspace insulation for this package, from the predefined list of the 
following values: 

 R0 

 R2 

 R3 

 R4 

 R5 

 R6 

 R12 

Basement Wall The level of basement wall insulation for this package, from the predefined list of the 
following values: 

 R0 

 R5 

 R6 

 R7 

 R8 

 R9 

 R11 

 R14 

 R15 

 R19 

 R28 

 R30 

Basement Floor The level of basement floor  insulation for this package, from the predefined list of the 
following values: 

 R0 

 R5 

 R6 

 R7 
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 R8 

 R9 

 R11 

 R14 

 R15 

 R19 

 R28 

 R30 

Floor The level of ceiling insulation for this package, from the predefined list of the following 
values: 

 R0 

 R11 

 R13 

 R14 

 R19 

 R26 

 R28 

 R30 

Window for  
Sizing calc Base Window The base window to be used for this location. This window is what the 

program uses to calculate the orientation specific results. 

Protected Record If this box is checked, the record is protected from editing. Protected records are 
generally those that are shipped with the program. Copying a protected record turns off 
the protection and allows the user to edit the copied record.  
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4.11.  Results Library 

The Results Library is used to view results from multiple records from the House Library. This can be 
extremely useful when trying to compare the impact of different window configurations on a building. The 
Results Library also has a feature that allows the data from these results to be exported to a file that can be 
imported into a spreadsheet program. 

4.11.1.  Results Library List View 

The Results Library List View shows the results from the House Library calculations.  

 

Figure 4-40.  The Results Library List View. 

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Modify List This allows the user to create lists that allow different collections of the results, by 
defining which results records are to be associated with each list. Clicking this button 
opens another dialog box where the results for each list can be defined, as shown in the 
following figure. 

 The fields in the Modify List dialog box are: 

 List Name: This is the name of the List, input by the user, which will appear in the 
List Name pull-down in the Results Library List View. 

 Description: This is a description of the List, input by the user. 

 Left hand table: The left hand table shows the House Library results that are not 
currently part of the current list. 

 Selection buttons: the Selection buttons are used to move results from the left hand 
table to the right hand table. The single arrow buttons move the currently 
highlighted records, the double arrow buttons move all the records. 

 Right hand table: The right hand table shows the House Library results that have 
been selected to be associated with this list. They can be removed with the “left 
pointing” Selection buttons, which will put them back into the left hand table. 
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 New List button: This button is used to make a new list. Clicking this button will 
open a new list with the the List Name and Description fields blank, and all the 
House Library results listed on the left hand table.  

 OK: The OK button is used to accept the changes to the List and return to the Results 
Library List View display. 

 Cancel: The Cancel button is used to return to the Results Library List View display 
without saving any changes made to the list. 

 

Figure 4-41.  The Modify List dialog box. 

 

Export Used to export the results in the list to a comma separated ASCII text file, which can 
then be imported into a spreadsheet program. 

Bar Chart Used to find a record in the library based on the Name field. When this button is clicked, 
a small dialog box will appear, and the beginning letters of the name can be typed, and 
the first record whose Name field starts with those letters will be highlighted. 
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4.11.2.  Results Library Detail View 

The Results Library Detail View is similar to the House Library Detail View except that the input values are 
not editable. It is merely a way to quickly see what the input variables were for a set of results. 

 

Figure 4-42.  The Results Library Detail View.  



4.12.  Electric Rate Library 4.  PROGRAM DESCRIPTION 

4-48 DECEMBER 2012 RESFEN 6.0 

4.12.  Electric Rate Library 

The Electric Rate Library is used to define electricity rates that are then used in the Location Library 
definitions and in the House Library Detail View in the House Data section. New rates can be added to the 
library and then used in the Location Library  

The default utility data for each location is from the National Association of Regulatory Utility 
Commissioners (NARUC) -- "Residential Electric Bills, Winter 1994-95", published May 31, 1996. 

4.12.1.  Electric Rate Library List View 

The Electric Rate Library List View shows all the electricity cost records in the currently open database.  

 

Figure 4-43.  The Electric Rate Library List View.  

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Copy Used to copy existing records to create new records which can then be edited as needed. 
Highlight the record or records to be copied (use Shift + left mouse click to select 
multiple contiguous records, or Ctrl + left mouse click to select multiple non-contiguous 
records), and click the Copy button. By default the program will increment the ID 
number based on the last ID value, but this can be changed by the user as long as the ID 
will unique for this library.  
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Delete Used to delete existing records. Highlight the record or records to be deleted (use Shift + 
left mouse click to select multiple contiguous records, or Ctrl + left mouse click to select 
multiple non-contiguous records), and click the Delete button. 

Goto/Find Used to find a record in the library based on the Name field. When this button is clicked, 
a small dialog box will appear, and the beginning letters of the name can be typed, and 
the first record whose Name field starts with those letters will be highlighted. 
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4.12.2.  Electric Rates Library Detail View 

The Electric Rate Library Detail View shows the input values for each individual record, as shown in the 
figure below. The input values for this library are quite simple, just the actual electricity cost. The default 
values are from the Efficient Windows Collaborative website (updated 2004), with one record per state. These 
values can be changed to reflect different prices, or new records can be created for specific cases. 

 

Figure 4-44.  The Electric Rate Library Detail View.  

The fields in the Electric Rate Library detailed view are the following: 

ID The ID of the record, set automatically by the program or by the user when copying an 
existing record. This ID must be unique. 

Rate Name Name of electric rate.  

Electric Cost The electricity rate.  

 Units: $0.00/kWh (IP and SI).  

 Legal Values: any number. 

 

List View Button This button is used to return to the List View of the library. 
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4.13.  Gas Rates Library 

The Gas Rate Library is used to define natural gas rates that are then used in the House Library Detail View in 
the House Data section. The default values are from the Efficient Windows Collaborative website (updated 
2004), with one record per state. These values can be changed to reflect different prices, or new records can be 
created for specific cases.  

The default utility data for each location is from the National Association of Regulatory Utility 
Commissioners (NARUC) -- "Residential Gas Bills, Summer 1995", published Jan. 18, 1996. 

4.13.1.  Gas Rates Library List View 

The Gas Rate Library List View shows all the electricity cost records in the currently open database. 

 

Figure 4-45.  The Gas Rate Library List View.  

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Copy Used to copy existing records to create new records which can then be edited as needed. 
Highlight the record or records to be copied (use Shift + left mouse click to select 
multiple contiguous records, or Ctrl + left mouse click to select multiple non-contiguous 
records), and click the Copy button. By default the program will increment the ID 
number based on the last ID value, but this can be changed by the user as long as the ID 
will unique for this library.  
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Delete Used to delete existing records. Highlight the record or records to be deleted (use Shift + 
left mouse click to select multiple contiguous records, or Ctrl + left mouse click to select 
multiple non-contiguous records), and click the Delete button. 

Goto/Find Used to find a record in the library based on the Name field. When this button is clicked, 
a small dialog box will appear, and the beginning letters of the name can be typed, and 
the first record whose Name field starts with those letters will be highlighted. 

4.13.2.  Gas Rates Library Detail View 

The Gas Rate Library Detail View shows the input values for each individual record, as shown in the figure 
below. The input values for this library are quite simple, just the actual gas cost. 

 

Figure 4-46.  The Gas Rate Library Detail View.  

The fields in the Electric Rate Library detailed view are the following: 

ID The ID of the record, set automatically by the program or by the user when copying an 
existing record. This ID must be unique. 

Rate Name Name of gas rate.  

Gas Cost The natural gas rate.  

 Units: $0.00/kWh (IP and SI).  

 Legal Values: any number. 

 

List View Button This button is used to return to the List View of the library. 
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5.  TECHNICAL REFERENCE 

5.1.  Location Library Data 

The Locations with the “ID” field completed are contained in the default RESFEN database file 

(RESFEN6.mdb). The other weather files will be added to the default database in the future. The weather files 

used in the Energy Star 2008 anaylsis, which is primarily what is in the default RESFEN database, are all 

TMY2 weather files. The California Climate Zone files (CTZ<nn>c.bin) are specially compiled weather data. 

The locations with a * in the E* column were used in the Energy Star 2008 analysis.  

Table 5-1.  RESFEN Locations 

E* ID 

State Abbreviation / City 

Name WeatherFile 

New Construction 

Package 

Existing 

Construction 

Package Default Foundation 

* 1 AK Anchorage AKANTMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 2 AK Annette AKATTMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 4 AK Bethel AKBETMY2.BIN IECC06 Zone 08 Exist03 (WV1) Basement 

 6 AK Big Delta AKBDTMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 7 AK Cold Bay AKCBTMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

* 8 AK Fairbanks AKFATMY2.BIN IECC06 Zone 08 Exist03 (WV1) Basement 

 9 AK Gulkana AKGUTMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 10 AK King Salmon AKKSTMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 11 AK Kodiak AKKOTMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 13 AK McGrath AKMCTMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 14 AK Nome AKNOTMY2.BIN IECC06 Zone 08 Exist03 (WV1) Basement 

 15 AK St. Paul Island AKSITMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 16 AK Talkeetna AKTATMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 17 AK Yakutat AKYATMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

* 18 AL Birmingham ALBITMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

 19 AL Huntsville ALHUTMY2.BIN IECC06 Zone 03 Exist02 (WV1) Slab-On_Grade 

* 20 AL Mobile ALMBTMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 

 21 AL Montgomery ALMNTMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

 22 AR Fort Smith ARFSTMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

* 23 AR Little Rock ARLRTMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

* 24 AZ Flagstaff AZFLTMY2.BIN IECC06 Zone 05 Exist01 (AL1) Slab-On_Grade 

* 25 AZ Phoenix AZPHTMY2.BIN IECC06 Zone 02 Exist01 (AL1) Slab-On_Grade 

* 26 AZ Prescott AZPRTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Slab-On_Grade 

* 27 AZ Tucson AZTUTMY2.BIN IECC06 Zone 02 Exist01 (AL1) Slab-On_Grade 

* 28 CA Arcata CAARTMY2.BIN IECC06 Zone 04 Marine Exist01 (AL1) Slab-On_Grade 

 29 CA Arcata (CTZ 01) ctz01c.BIN IECC06 Zone 04 Marine Exist01 (AL1) Slab-On_Grade 

* 30 CA Bakersfield CABATMY2.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

 31 CA China Lake (CTZ 14) ctz14c.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

* 32 CA Daggett CADATMY2.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

 33 CA El Centro (CTZ 15) ctz15c.BIN IECC06 Zone 02 Exist01 (AL1) Slab-On_Grade 

 34 CA El Toro (CTZ 08) ctz08c.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

* 35 CA Fresno CAFRTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

 36 CA Fresno (CTZ 13) ctz13c.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

* 37 CA Los Angeles CALATMY2.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 
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E* ID 

State Abbreviation / City 

Name WeatherFile 

New Construction 

Package 

Existing 

Construction 

Package Default Foundation 

 38 CA Long Beach CALBTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

 39 CA Long Beach (CTZ 06) ctz06c.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

 40 CA Mt. Shasta (CTZ 16) ctz16c.BIN IECC06 Zone 05 Exist01 (AL1) Slab-On_Grade 

 41 CA Oakland (CTZ 03) ctz03c.BIN IECC06 Zone 03 Marine Exist01 (AL1) Slab-On_Grade 

 42 CA Pasadena (CTZ 09) Ctz09c.bin IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

* 43 CA Red Bluff ctz11c.bin IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

 44 CA Red Bluff (CTZ 11) Ctz11c.bin IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

 45 CA Riverside (CTZ 10) ctz10c.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

* 46 CA Sacramento CASCTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

 47 CA Sacramento (CTZ 12) ctz12c.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

* 48 CA San Diego CASDTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

 49 CA San Diego (CTZ 07) ctz07c.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

* 50 CA San Francisco CASFTMY2.BIN IECC06 Zone 03 Marine Exist01 (AL1) Slab-On_Grade 

 51 CA Santa Maria CASMTMY2.BIN IECC06 Zone 03 Marine Exist01 (AL1) Slab-On_Grade 

 52 CA Santa Maria (CTZ 05) ctz05c.BIN IECC06 Zone 03 Marine Exist01 (AL1) Slab-On_Grade 

 53 CA Santa Rosa (CTZ 02) ctz02c.BIN IECC06 Zone 03 Marine Exist01 (AL1) Slab-On_Grade 

 54 CA Sunnyvale (CTZ 04) ctz04c.BIN IECC06 Zone 03 Marine Exist01 (AL1) Slab-On_Grade 

 55 CO Alamosa COALTMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 

* 56 CO Denver COBOTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 57 CO Colorado Springs COCSTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 58 CO Eagle COEATMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 

* 59 CO Grand Junction COGJTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 60 CO Pueblo COPUTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 61 CT Bridgeport CTBRTMY2.BIN IECC06 Zone 05 Exist03 (WV1) Basement 

* 62 CT Hartford CTHATMY2.BIN IECC06 Zone 05 Exist03 (WV1) Basement 

* 63 DE Wilmington DEWLTMY2.BIN IECC06 Zone 04 Exist01 (WV1) Basement 

* 64 FL Daytona Beach FLDBTMY2.BIN IECC06 Zone 02 Exist01 (AL1) Slab-On_Grade 

* 65 FL Jacksonville FLJATMY2.BIN IECC06 Zone 02 Exist01 (AL1) Slab-On_Grade 

 66 FL Key West FLKWTMY2.BIN IECC06 Zone 01 Exist01 (AL1) Slab-On_Grade 

* 67 FL Miami FLMITMY2.BIN IECC06 Zone 01 Exist01 (AL1) Slab-On_Grade 

* 68 FL Tallahassee FLTLTMY2.BIN IECC06 Zone 02 Exist01 (AL1) Slab-On_Grade 

* 69 FL Tampa FLTMTMY2.BIN IECC06 Zone 02 Exist01 (AL1) Slab-On_Grade 

 70 FL West Palm Beach FLWPTMY2.BIN IECC06 Zone 02 Exist01 (AL1) Slab-On_Grade 

 71 GA Athens GAATtmy2.bin IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

* 72 GA Atlanta GAATTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

 73 GA Augusta GAAUTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

 74 GA Columbus GACOTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

 75 GA Macon GAMATMY2.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

* 76 GA Savannah GASATMY2.BIN IECC06 Zone 02 Exist01 (AL1) Slab-On_Grade 

 77 HI Hilo HIHITMY2.BIN IECC06 Zone 01 Exist01 (AL1) Slab-On_Grade 

* 78 HI Honolulu HIHOTMY2.BIN IECC06 Zone 01 Exist01 (AL1) Slab-On_Grade 

 79 HI Kahului HIKATMY2.BIN IECC06 Zone 01 Exist01 (AL1) Slab-On_Grade 

 80 HI Lihue HILITMY2.BIN IECC06 Zone 01 Exist01 (AL1) Slab-On_Grade 

* 81 IA Des Moines IADMTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 82 IA Mason City IAMCTMY2.BIN IECC06 Zone 06 Exist02 (WV1) Basement 

 83 IA Sioux City IASCTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 84 IA Waterloo IAWATMY2.BIN IECC06 Zone 06 Exist02 (WV1) Basement 
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* 85 ID Boise IDBOTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 86 ID Pocatello IDPOTMY2.BIN IECC06 Zone 06 Exist02 (WV1) Basement 

* 87 IL Chicago ILCHTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 88 IL Evansville ILEVTMY2.BIN IECC06 Zone 04 Exist02 (WV1) Basement 

 89 IL Moline ILMOTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 90 IL Peoria ILPETMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 91 IL Rockford ILROTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

* 92 IL Springfield ILSPTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 93 IN Fort Wayne INFWTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

* 94 IN Indianapolis ININTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 95 IN South Bend INSBTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 96 KS Dodge City KSDCTMY2.BIN IECC06 Zone 04 Exist02 (WV1) Basement 

 97 KS Goodland KSGOTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 98 KS Topeka KSTOTMY2.BIN IECC06 Zone 04 Exist02 (WV1) Basement 

* 99 KS Wichita KSWITMY2.BIN IECC06 Zone 04 Exist02 (WV1) Basement 

 100 KY Covington KYCOTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Crawlspace 

* 101 KY Lexington KYLETMY2.BIN IECC06 Zone 04 Exist01 (AL1) Crawlspace 

* 102 KY Louisville KYLOTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Crawlspace 

 103 LA Baton Rouge LABRTMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 

* 104 LA Lake Charles LALCTMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 

* 105 LA New Orleans LANOTMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 

* 106 LA Shreveport LASHTMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

* 107 MA Boston MABOTMY2.BIN IECC06 Zone 05 Exist03 (WV1) Basement 

 108 MA Worchester MAWOTMY2.BIN IECC06 Zone 05 Exist03 (WV1) Basement 

* 109 MD Baltimore MDBATMY2.BIN IECC06 Zone 04 Exist01 (WV1) Basement 

 110 ME Caribou MECATMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

* 111 ME Portland MEPOTMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

 112 MI Alpena MIALTMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

* 113 MI Detroit MIDETMY2.BIN IECC06 Zone 05 Exist03 (WV1) Basement 

 114 MI Flint MIFLTMY2.BIN IECC06 Zone 05 Exist03 (WV1) Basement 

* 115 MI Grand Rapids MIGRTMY2.BIN IECC06 Zone 05 Exist03 (WV1) Basement 

* 116 MI Houghton MIHOTMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 117 MI Lansing MILATMY2.BIN IECC06 Zone 05 Exist03 (WV1) Basement 

 118 MI Muskegon MIMUTMY2.BIN IECC06 Zone 05 Exist03 (WV1) Basement 

 119 MI Sault Ste. Marie MISMTMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 120 MI Traverse City MITCTMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

* 121 MN Duluth MNDUTMY2.BIN IECC06 Zone 07 Exist02 (WV1) Basement 

* 122 MN International Falls MNIFTMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

* 123 MN Minneapolis MNMITMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

 124 MN Rochester MNROTMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

 125 MN Saint Cloud MNSCTMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

 126 MO Columbia MOCOTMY2.BIN IECC06 Zone 04 Exist03 (WV1) Basement 

* 127 MO Kansas City MOKCTMY2.BIN IECC06 Zone 04 Exist03 (WV1) Basement 

 128 MO Springfield MOSPTMY2.BIN IECC06 Zone 04 Exist03 (WV1) Basement 

* 129 MO St. Louis MOSTTMY2.BIN IECC06 Zone 04 Exist03 (WV1) Basement 

* 130 MS Jackson MSJATMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

 131 MS Meridian MSMETMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 
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* 132 MT Billings MTBITMY2.BIN IECC06 Zone 06 Exist02 (WV1) Basement 

 133 MT Cut Bank MTCBTMY2.BIN IECC06 Zone 06 Exist02 (WV1) Basement 

 134 MT Glasgow MTGLTMY2.BIN IECC06 Zone 06 Exist02 (WV1) Basement 

* 135 MT Great Falls MTGFTMY2.BIN IECC06 Zone 06 Exist02 (WV1) Basement 

 136 MT Helena MTHETMY2.BIN IECC06 Zone 06 Exist02 (WV1) Basement 

 137 MT Kalispell MTKATMY2.BIN IECC06 Zone 06 Exist02 (WV1) Basement 

 138 MT Lewistown MTLETMY2.BIN IECC06 Zone 06 Exist02 (WV1) Basement 

 139 MT Miles City MTMCTMY2.BIN IECC06 Zone 06 Exist02 (WV1) Basement 

 140 MT Missoula MTMITMY2.BIN IECC06 Zone 06 Exist02 (WV1) Basement 

 141 NC Asheville NCASTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Crawlspace 

 142 NC Cape Hatteras NCCHTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Crawlspace 

* 143 NC Charlotte NCCRTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Crawlspace 

 144 NC Greensboro NCGRTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Crawlspace 

* 145 NC Raleigh NCRATMY2.BIN IECC06 Zone 04 Exist01 (AL1) Crawlspace 

 146 NC Wilmington NCWITMY2.BIN IECC06 Zone 03 Exist01 (AL1) Crawlspace 

* 147 ND Bismarck NDBITMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

 148 ND Fargo NDFATMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 149 ND Minot NDMITMY2.BIN IECC06 Zone 07 Exist03 (WV1) Basement 

 150 NE Grand Island NEGITMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 151 NE Norfolk NENOTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 152 NE North Platte NENPTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

* 153 NE Omaha NEOMTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 154 NE Scottsbluff NESCTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

* 155 NH Concord NHCOTMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

* 156 NJ Atlantic City NJACTMY2.BIN IECC06 Zone 04 Exist01 (WV1) Basement 

 157 NJ Newark NJNETMY2.BIN IECC06 Zone 04 Exist01 (WV1) Basement 

* 158 NM Albuquerque NMALTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Slab-On_Grade 

 159 NM Tucumcari NMTUTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Slab-On_Grade 

 160 NV Elko NVEKTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Slab-On_Grade 

 161 NV Ely NVELTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Slab-On_Grade 

* 162 NV Las Vegas NVLVTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Slab-On_Grade 

* 163 NV Reno NVRETMY2.BIN IECC06 Zone 05 Exist01 (WV1) Slab-On_Grade 

 164 NV Tonopah NVTOTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Slab-On_Grade 

 165 NV Winnemucca NVWITMY2.BIN IECC06 Zone 05 Exist01 (WV1) Slab-On_Grade 

* 166 NY Albany NYALTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 167 NY Binghamton NYBITMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 

* 168 NY Buffalo NYBUTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 169 NY Massena NYMATMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 

* 170 NY New York City NYNYTMY2.BIN IECC06 Zone 04 Exist01 (WV1) Basement 

 171 NY Rochester NYROTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 172 NY Syracuse NYSYTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 173 OH Akron OHAKTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

* 174 OH Cleveland OHCLTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 175 OH Columbus OHCOTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

* 176 OH Dayton OHDATMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 177 OH Mansfield OHMATMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 178 OH Toledo OHTOTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 
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 179 OH Youngstown OHYOTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

* 180 OK Oklahoma City OKOCTMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

 181 OK Tulsa OKTUTMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

 182 OR Astoria ORASTMY2.BIN IECC06 Zone 04 Marine Exist02 (WV1) Crawlspace 

 183 OR Burns ORBUTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Crawlspace 

 184 OR Eugene OREUTMY2.BIN IECC06 Zone 04 Marine Exist02 (WV1) Crawlspace 

* 185 OR Medford ORMETMY2.BIN IECC06 Zone 04 Marine Exist02 (WV1) Crawlspace 

 186 OR North Bend ORNBTMY2.BIN IECC06 Zone 04 Marine Exist02 (WV1) Crawlspace 

 187 OR Pendleton ORPETMY2.BIN IECC06 Zone 05 Exist02 (WV1) Crawlspace 

* 188 OR Portland ORPOTMY2.BIN IECC06 Zone 04 Marine Exist02 (WV1) Crawlspace 

 189 OR Redmond ORRETMY2.BIN IECC06 Zone 05 Exist02 (WV1) Crawlspace 

 190 OR Salem ORSATMY2.BIN IECC06 Zone 04 Marine Exist02 (WV1) Crawlspace 

 191 PA Allentown PAALTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 192 PA Bradford PABRTMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 

 193 PA Erie PAERTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 194 PA Harrisburg PAHATMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

* 195 PA Philadelphia PAPHTMY2.BIN IECC06 Zone 04 Exist01 (WV1) Basement 

* 196 PA Pittsburgh PAPITMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 197 PA Wilkes-Barre PAWBTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

* 198 PA Williamsport PAWITMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 199 PI Guam PIGUTMY2.BIN IECC06 Zone 01 Exist01 (AL1) Slab-On_Grade 

 200 PR San Juan PRSJTMY2.BIN IECC06 Zone 01 Exist01 (AL1) Slab-On_Grade 

* 201 RI Providence RIPRTMY2.BIN IECC06 Zone 05 Exist03 (WV1) Basement 

* 202 SC Charleston SCCHTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Crawlspace 

 203 SC Columbia SCCOTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Crawlspace 

* 204 SC Greenville SCGRTMY2.BIN IECC06 Zone 03 Exist01 (AL1) Crawlspace 

 205 SD Huron SDHUTMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

* 206 SD Pierre SDPITMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 

 207 SD Rapid City SDRCTMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 

 208 SD Sioux Falls SDSFTMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 

 209 TN Bristol TNBRTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Crawlspace 

 210 TN Chattanooga TNCHTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Crawlspace 

 211 TN Knoxville TNKNTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Crawlspace 

* 212 TN Memphis TNMETMY2.BIN IECC06 Zone 03 Exist01 (AL1) Crawlspace 

* 213 TN Nashville TNNATMY2.BIN IECC06 Zone 04 Exist01 (AL1) Crawlspace 

 214 TX Abilene TXABTMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

* 215 TX Amarillo TXAMTMY2.BIN IECC06 Zone 04 Exist02 (AL1) Slab-On_Grade 

 216 TX Austin TXAUTMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 

* 217 TX Brownsville TXBRTMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 

 218 TX Corpus Christi TXCCTMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 

* 219 TX El Paso TXEPTMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

* 220 TX Fort Worth TXFWTMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

* 221 TX Houston TXHOTMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 

* 222 TX Lubbock TXLBTMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

 223 TX Lufkin TXLFTMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 

 224 TX Midland TXMITMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

 225 TX Port Arthur TXPATMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 
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 226 TX San Angelo TXSGTMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

* 227 TX San Antonio TXSNTMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 

 228 TX Victoria TXVITMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 

 229 TX Waco TXWATMY2.BIN IECC06 Zone 02 Exist02 (AL1) Slab-On_Grade 

 230 TX Wichita Falls TXWFTMY2.BIN IECC06 Zone 03 Exist02 (AL1) Slab-On_Grade 

* 231 UT Cedar City UTCCTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

* 232 UT Salt Lake City UTSLTMY2.BIN IECC06 Zone 05 Exist01 (WV1) Basement 

 233 VA Lynchburg VALYTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Basement 

 234 VA Norfolk VANOTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Basement 

* 235 VA Richmond VARITMY2.BIN IECC06 Zone 04 Exist01 (AL1) Basement 

 236 VA Roanoke VAROTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Basement 

* 237 DC Washington (Sterling, VA) VASTTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Basement 

* 238 VT Burlington VTBUTMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

 239 WA Olympia WAOLTMY2.BIN IECC06 Zone 04 Marine Exist02 (WV1) Basement 

 240 WA Quillayute WAQUTMY2.BIN IECC06 Zone 04 Marine Exist02 (WV1) Basement 

* 241 WA Seattle WASETMY2.BIN IECC06 Zone 04 Marine Exist02 (WV1) Basement 

* 242 WA Spokane WASPTMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 243 WA Yakima WAYATMY2.BIN IECC06 Zone 05 Exist02 (WV1) Basement 

 244 WI Eau Claire WIECTMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

 245 WI Green Bay WIGBTMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

 246 WI La Crosse WILCTMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

* 247 WI Madison WIMATMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

 248 WI Milwaukee WIMITMY2.BIN IECC06 Zone 06 Exist03 (WV1) Basement 

* 249 WV Charleston WVCHTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Basement 

 250 WV Elkins WVELTMY2.BIN IECC06 Zone 05 Exist01 (AL1) Basement 

 251 WV Huntington WVHUTMY2.BIN IECC06 Zone 04 Exist01 (AL1) Basement 

 252 WY Casper WYCATMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 

* 253 WY Cheyenne WYCHTMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 

 254 WY Lander WYLATMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 

 255 WY Rock Springs WYRSTMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 

 256 WY Sheridan WYSHTMY2.BIN IECC06 Zone 06 Exist01 (WV1) Basement 
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5.2.  RESFEN Modeling Assumptions 

The following table contains the input value assumptions used for the DOE2 simulations in RESFEN 6. These 

are the modeling assumptions that were used in the Energy Star 2008 development work. 

More information about the Energy Star 2008 analysis can be found at the following website: 

http://windows.lbl.gov/estar2008/ 

 

Table 5-2.  Modeling Assumptions 

PARAMETER DESCRIPTION  

Floor Area 

(ft2 & dimensions) 

Variable, from 1,000 to 4,000 square feet, input by user. 

 

The defaults for the Energy Star 2008 analysis were: 

New – 1 Story: 1700sf 

New – 2 Story: 2800sf 

Existing 1 Story: 1700sf 

Existing 2 Story: 2600sf 

House Type New Construction 

Existing Construction 

Foundation Foundation is based on location. There are a maximum of three options per climate zone, chosen from: 

Basement 

Slab-on-Grade 

Crawlspace 

See Table 6-1. (b) 

Insulation Envelope insulation levels are based on the IECC 2006 Climate Zone of the location. See Table 6-1 for a 

list of Packages that correspond to each location. See Tables 6-3 and 6-4 for a list of R-values for each 

building component for package 

 

New construction:  See Table 6-4. (based on IECC 2006 envelope requirements) (c) 

Existing construction:  See Table 6-5. (Ritschard, et al. 1992) 

Infiltration New Construction:  SLA = 0.00036 

Existing Construction:  SLA = 0.00054 

 

Consistent with 2006 IECC reference home Table 404.5.2(1) average value. 

Structural Mass (lb/ft2) 3.5 lb/ft2 of floor area for interior mass, in accordance with the Model Energy Code and NFRC Annual 

Energy Performance Subcommittee recommendation (September 1998). 

 

Where masonry floors are used: 

80% of floor area covered by R‐2 carpet and pad, and 20% of floor directly exposed to room air. This is 

in addition to the 3.5 lb/ft2 

 

For Basement walls: masonry, and include insulation located on the exterior of the walls (new 

construction) and the interior side of the walls (existing construction). This is in addition to above. 
Internal Mass 

Furniture (lb/ft2) 

8.0 lb/ft2 of floor area. 

 

Consistent with 2006 IECC reference home Table 404.5.2(1). 

Solar Gain Reduction The Energy Star 2008 analysis used the “Typical” option. 

 

Options: 

None:  No solar gain reduction 

Overhang:  2’ Exterior Overhangs 

Obstruction:  Exterior Obstructions, a completely opaque (=0.0), same-height obstruction 20 feet 

away, intended to represent adjacent buildings. 

http://windows.lbl.gov/estar2008/
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Interior:  Interior shades with a Seasonal SHGC multiplier, summer value = 0.80, winter value = 0.90. 

Int+Ovh:  Interior shades & 2' overhangs 

Ovh+Obs:  2' overhangs & obstructions 

All:  Interior shades, 2' overhangs, & obstructions 

Typical(d):   to represent a statistically average solar gain reduction for a generic house, this option 

includes: 

Interior shades (Seasonal SHGC multiplier, summer value = 0.80, winter value = 0.90); 

1' overhang;  

a 67% transmitting same-height obstruction 20' away intended to represent adjacent buildings. 

To account for other sources of solar heat gain reduction (insect screens, trees, dirt, building & 

window self-shading), the SHGC multiplier was further reduced by 0.1. This results in a final 

winter SHGC multiplier of 0.8 and a final summer SHGC multiplier of 0.7.  

Window Area 

(% Floor Area) 

Variable, input by the user. 

 

The Energy Star 2008 analysis used 15% of floor area  

Window Type Variable, input by the user. 

Window Distribution Variable, input by the user. 

 

For the Energy Star 2008 analysis, the windows were distributed evenly on all four orientations. 

HVAC System Furnace & A/C,  

Electric Heat Pump 

HVAC System Sizing For Existing Contruction: 

For each climate, system sizes are fixed for all window options. Fixed sizes are based on the use of 

DOE-2 auto-sizing for the same house as defined in the analysis, with the most representative window 

for that specific climate. An auto-sizing multiplier of 1.3 used to account for a typical safety factor. (e) 

 

For New Construction: 

The DOE2 auto-sizing option was used on the specific windows used for each simulation. 

HVAC Efficiency New Construction: 

AFUE = 0.80 for IECC Climate Zones 1-3, 0.90 in IECC Climate Zones 4-8 

 A/C SEER=13 

Heat Pump HSPF = 7.7 

 

Existing Construction: 

AFUE = 0.78 

A/C (and Heat Pump)  SEER= 10 

Heat Pump HSPF = 6.8 

Duct Losses 12% for basement foundation 

20% for crawlspace and slab-on-grade foundations 

Part-Load Performance New part-load curves for DOE2 (Henderson 1998) for both new and existing house types 

Thermostat Settings Heating:  70oF, Cooling:  78oF 

Basement (partially conditioned): Heating 62oF, Cooling 85oF 

Night Heating Setback 65oF (11 PM – 6 AM(f)  ) 

Internal Loads From IECC Table 404.5.2(1) 

 

Internal gain (Btu/day) = 17,900 + 23.8 * floor area + 4104 * number of bedrooms 

 

Where 3 bedrooms were assumed 

Natural Ventilation Maximum operable window area reduced from 25% to 12.5%. Max ACH capped at 10. Based on 

California Research on use of windows for ventilation. 
Weather Data All TMY2(h) 

Number of Locations 239 US cities(h) 

4 Canadian cities 

Calculation Tool DOE-2.1E 

Footnotes: 
(a) RESFEN allows the floor area to vary, so floor-area-dependent parameters (such as exterior and interior wall area, perimeter 

area, internal gains, infiltration, and so forth) are calculated for each specific case. 
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(b) In Table 6-1, the default foundation option is the most common foundation type in that location; the other options are other 

foundation types found in more than 10% of the houses according to a National Association of Homebuilder's survey (Labs et 

al. 1988). 

(c) The insulation levels for the different building components are based on Table 402.1.1 in IECC 2006. 

(d) These assumptions are intended to represent the average solar heat gain reduction for a large sample of houses. A one-foot 

overhang is assumed on all four orientations in order to represent the average of a two-foot overhang and no overhang. A 67% 

transmitting obstruction 20 feet away on all four orientations represents the average of obstructions (such as neighboring 

buildings and trees) 20 feet away on one-third of the total windows and no obstructions in front of the remaining two-thirds of 

windows. An interior shade is assumed to have a Solar Heat Gain Coefficient multiplier of 0.9 during the winter and 0.8 

during the summer. To account for solar heat gain reducing effects from other sources such as screens, trees, dirt, and self-

shading of the building, the SHGC multiplier was further reduced by 0.1 throughout the year. This amounts to a 12.5% 

decrease in the summer and an 11.1% decrease in the winter. The final SHGC multipliers (0.8 in the winter and 0.7 in the 

summer) thus reflect the combined effects of shading devices and other sources. 

(e)  

(f) RESFEN models a moderate setback of 65o F in recognition that some but not all houses may use night setbacks. Recent 

studies of residential indoor conditions have shown that, during the heating season, nighttime temperatures are significantly 

lower than daytime temperatures (Ref: “Occupancy Patterns and Energy Consumption in New California Houses,” Berkeley 

Solar Group for the California Energy Commission, 1990). 

(g) RESFEN uses a feature in DOE-2 that allows the ventilation temperature to switch between a higher heating (or winter) and a 

lower cooling (or summer) temperature based on the cooling load over the previous four days. 

(h) RESFEN uses Typical Meteorologcal Year (TMY2) weather tapes from the National Renewable Energy Laboratory. There are 

239 TMY2 locations with average weather data compiled from 30+ years of historical weather data. 



5.  TECHNICAL REFERENCE 

6-10 DECEMBER 2012 RESFEN 6.0 

5.3.  Simulation Envelope Insulation Values 

 

Table 5-3.  RESFEN New Construction Insulation Values (IECC 2006)  

IECC Climate Zone 
Ceiling 

R-value 

Wall  

R-value 

Slab 

R-value 

Basement  

Wall R-value 

Basement  

Floor R-value 

Floor 

R-value 

IECC06-Zone01 30 13 0 0 0 13 

IECC06-Zone02 30 13 0 0 0 13 

IECC06-Zone03 30 13 0 0 0 19 

IECC06-Zone03 Marine 30 13 0 0 0 19 

IECC06-Zone04 38 13 2 14 0 19 

IECC06-Zone04 Marine 38 19 2 14 0 30 

IECC06-Zone05 38 19 2 14 0 30 

IECC06-Zone06 49 19 4 14 0 30 

IECC06-Zone07 49 21 4 14 0 30 

IECC06-Zone08 v 21 4 14 0 30 

 

Table 5-4.  RESFEN5 Existing Construction Insulation Values. (Ritschard, et. al. 1992) 

Package Name 
Ceiling 

R-value 

Wall  

R-value 

Slab 

R-value 

Basement  

Wall R-value 

Basement  

Floor R-value 

Floor 

R-value 
Window for sizing 

Exist01 (AL1) 11 7 0 0 0 0 Single, Aluminum Frame 

Exist01 (WV1) 11 7 0 0 0 0 Single, Wood/Vinyl Frame 

Exist02 (AL1) 19 7 0 0 0 0 Single, Aluminum Frame 

Exist02 (WV1) 19 7 0 0 0 0 Single, Wood/Vinyl Frame 

Exist03 (WV1) 22 7 0 0 0 0 Single, Wood/Vinyl Frame 
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5.4.  Using WINDOW DOE2 Input File for RESFEN Calculations 

Window Library entries created in WINDOW can be imported into the RESFEN Window Library. In 

addition, the detailed DOE2 input file generated by WINDOW for windows can also be used in the RESFEN 

analysis for a more accurate definition of the glazing in the window. Importing records from a WINDOW 

database are discussed in Section 4  in the Glass Library section. 

To use the WINDOW DOE2 Input file in a RESFEN calculation, the *dat” file from WINDOW must be 

specified, and the calculation procedure “turned on”. Both these functions are found in the Options dialog 

box, opened by clicking on the Options menu. 

Figure 5-1.  To use the DOE2 detailed input file from WINDOW (specified as a “dat” file),  

go to the Options dialog box from the Options menu.  

Check the “Use 
DOE-2 Glass-
Type-Code model” 
checkbox 

Specify the “dat” 
file from 
WINDOW5 to be 
used by RESFEN. 

Use the Browse 
button to specify 
the location of the 
“dat” file 
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5.5.  RESFEN Window Library (from WINDOW) Documentation 

 

ID window_Name 

Frame 

Type 

# Glass 

Layers 

Glazing 

Description 

Gas  

(See Note 

for 

Air/Argon) 

Gap 

Width 

(inches) 

Total Window 

U-factor 

(Btu/hr-

ft2-oF) SHGC Tvis 

10 Single Clear - Alum. Frame AL 1 Clear N/A N/A 1.291 0.735 0.695 

102 Double Clear - Alum. Frame AL 2 Clear Air 0.375 0.833 0.647 0.628 

103 Double Tinted - Alum. Frame AL 2 Tint Air 0.375 0.833 0.545 0.473 

104 

Double Low-E, High Solar 

Gain, Alum.Improv. Frame ALI 2 

High Solar 

Gain Low-E Argon 0.5 0.645 0.577 0.607 

105 

Double Low-E, Med Solar Gain, 

Alum.Improv. Frame ALI 2 

Medium Solar 

Gain Low-E Argon 0.5 0.636 0.381 0.556 

106 

Double Low-E, Low Solar Gain, 

Alum.Improv. Frame ALI 2 

Low Solar 

Gain Low-E Argon 0.5 0.63 0.261 0.492 

107 

Double Clear, Alum. Frame 

w/Thermal Break ATB 2 Clear Air 0.5 0.597 0.618 0.628 

108 

Double Tint, Alum. Frame 

w/Thermal Break ATB 2 Tint Air 0.5 0.597 0.514 0.473 

109 

Double Low-E, High Solar 

Gain, Alum. Frame 

w/Improv.Thermal Break ATBI 2 

High Solar 

Gain Low-E Argon 0.5 0.423 0.547 0.607 

110 

Double Low-E, Med Solar Gain, 

Alum. Frame 

w/Improv.Thermal Break ATBI 2 

Medium Solar 

Gain Low-E Argon 0.5 0.415 0.350 0.556 

111 

Double Low-E, Low Solar Gain, 

Alum. Frame 

w/Improv.Thermal Break ATBI 2 

Low Solar 

Gain Low-E Argon 0.5 0.409 0.231 0.492 

112 Single Clear, Non-metal Frame WV 1 Clear N/A N/A 0.879 0.640 0.648 

113 Double Clear, Non-metal Frame W/V 2 Clear Air 0.5 0.517 0.570 0.585 

114 Double Tint, Non-metal Frame W/V 2 Tint Air 0.5 0.517 0.473 0.441 

115 

Double Low-E, High Solar 

Gain, Non-metal Thermally 

Improved Frame W/VI 2 

High Solar 

Gain Low-E Argon 0.5 0.285 0.497 0.566 

116 

Double Low-E, Med Solar Gain, 

Non-metal Thermally Improved 

Frame W/VI 2 

Medium Solar 

Gain Low-E Argon 0.5 0.278 0.313 0.518 

117 

Double Low-E, Low Solar Gain, 

Non-metal Thermally Improved 

Frame W/VI 2 

Low Solar 

Gain Low-E Argon 0.5 0.272 0.202 0.459 

118 

Triple Low-E, High Solar Gain, 

Non-metal Thermally Improved 

Frame W/VI 3 

High Solar 

Gain Low-E Argon 0.375 0.196 0.407 0.498 

119 

Triple Low-E, Med Solar Gain, 

Non-metal Thermally Improved 

Frame W/VI 3 

Medium Solar 

Gain Low-E Argon 0.375 0.193 0.281 0.454 

120 

Triple Low-E, Low Solar Gain, 

Non-metal Thermally Improved 

Frame W/VI 3 

Low Solar 

Gain Low-E Argon 0.375 0.189 0.184 0.369 

NOTES: 
FRAME TYPE CODES: 

AL = Aluminum 

ATB = Aluminum, Thermally Broken 

W/V = Wood/Vinyl 

I = Thermally Improved Frame 

GAS FILLS: 

 Argon = 90% air, 10% argon 

WINDOW PROPERTIES: 

The properties for U-factor, SHGC, and Tvis were calculated with WINDOW 6.3.72 (2012). 
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The data presented here and in RESFEN are average properties for several commercially available products.  Specific products will 

perform slightly above or below the average products defined here.  Users are encouraged to only use these numbers as a general 

guide and to use specific manufacturer's product data (i.e. NFRC U-factors and Solar Heat Gain Coefficients) whenever possible. 

 

5.6.  Resources 

The following listings are resources for learning more about energy-efficient windows: 

5.6.1.  Books 

Residential Windows, A Guide to New Technologies and Energy Performance 

by John Carmody, Stephen Selkowitz, and Lisa Heschong 

W.W.W. Norton & Company, 1996. 

Updated material from this book can be found at the web site www.efficientwindows.org. 

 

5.6.2.  Organizations 

Efficient Windows Collaborative 

Alliance to Save Energy 

1200 18th Street N.W., Suite 900 

Washington, DC 20036 

Phone:  (202) 857-0666 

Fax: (202) 331-9588 

Web site: www.efficientwindows.org 

National Fenestration Rating Council 

1300 Spring Street, Suite 500 

Silver Spring, MD 20910 

Phone: (301) 589-NFRC 

Web site:  www.nfrc.org 

Windows and Daylighting Group 

Lawrence Berkeley National Laboratory 

MS 90-3111 

1 Cyclotron Road 

Berkeley, CA 94720 

Web site:  windows.lbl.gov 

 

http://www.nfrc.org/
http://www.nfrc.org/
http://www.nfrc.org/


5.  TECHNICAL REFERENCE 

6-14 DECEMBER 2012 RESFEN 6.0 

5.7.  References 

American Society of Heating, Refrigeration, and Air-Conditioning Engineers (ASHRAE) 1997. WYEC2 User’s 

Manual, Atlanta GA. 

Arasteh, D. K., E. U. Finlayson, and C. Huizenga. 1994. "WINDOW 4.1 : A PC program for analyzing window 

thermal performance in accordance with standard NFRC procedures". LBL-35298, Lawrence Berkeley 

Laboratory, Berkeley, Calif. 

Council of American Building Officials (CABO). 1993. Model Energy Code. Falls Church, Va. 

Henderson, H., Y. J. Huang, and D. Parker. 1999. "Residential equipment part-load curves for use in DOE-2". 

LBL-42145, Lawrence Berkeley National Laboratory, Berkeley, Calif. 

Huang, Y. J., R. Ritschard,  I. Turiel, S. Byrne, D. Wilson, C. Hsui, J. Bull, R. Sullivan, L. Chang, and P. 

Albrand. 1987. "Methodology and assumptions for evaluating heating and cooling energy requirements in 

new single-family residential buildings. Technical support document for the PEAR microcomputer program". 

LBL-19128, Lawrence Berkeley Laboratory, Berkeley, Calif. 

Labs, K., J. Carmody, R. Sterling, L. Shen, Y. J. Huang, and D. Parker. 1988. Building Foundation Design 

Handbook. ORNL/Sub/86-72143/1, Oak Ridge National Laboratory, Oak Ridge, Tenn. 

Lawrence Berkeley Laboratory (LBL) and Los Alamos Scientific Laboratory. 1980. DOE-2 Reference Manual, 

Parts 1 and 2.  LBL-8706 Rev. 1/LA-7689-M Ver 2.1, Lawrence Berkeley Laboratory, Berkeley, Calif. 

National Energy Renewable Laboratory (NREL). 1995. TMY2 User's Manual.  Golden, Colo.  

Ritschard, R., J. W. Hanford, and A. O. Sezgen. 1992. "Single-family heating and cooling requirements: 

assumptions, methods, and summary results", GRI-91/0236, Gas Research Institute, Chicago, Ill. 

Winkelmann, F. C., B. E. Birdsall, W. F. Buhl, K. L. Ellington, A. E. Erdem, J. J. Hirsch, and S. Gates. 1993.  

"DOE-2 Supplement. Version 2.1E", pp. 2-98 through 2-117 (Window Library), LBL-34947, Lawrence Berkeley 

Laboratory, Berkeley, Calif.

 



RESFEN 6.0 DECEMBER 2012 6-1 

6.  ACKNOWLEDGEMENTS  

The development of RESFEN6 was supported by the Assistant Secretary for Energy Efficiency and 

Renewable Energy; Office of Building Technology, State and Community Programs; Office of Building 

Systems of the U.S. Department of Energy under Contract No. DE-AC03-76SF00098. The authors 

appreciate the assistance of the following colleagues in the design and development of RESFEN:  Fred 

Buhl, Ender Erdem, Rob Hitchcock, Steve Selkowitz, and Fred Winkelmann. The user interface was 

developed by Santosh Philip of Gabel Associates, Berkeley, California. Development of the modeling 

assumptions for use in RESFEN was a collaborative process between LBNL staff and NFRC members; the 

authors wish to acknowledge the significant effort and contributions from many in the window 

community. 

 




